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This button closes the dialog and saves any changes made.



This button closes the dialog and ignores any changes made.



 File|Undelete...
This item is used to restore deleted files.

The hotkey for this command is <Ins>. This command is disabled if no files are selected.



 File|Remove
This menu item removes the selected files from the SafeDEL Trashcan and frees the occupied disk 
space. You cannot restore these files after they had been removed!

You only need this command to free some disk space or to remove files which are not likely needed to be 
restored.

The hotkey for this command is <Del>. This command is disabled if no files are selected.



 File|Change drive...
With this command you can select the drive which contents is displayed in the file list. The dialog box 
displays all drives that are currently protected by SafeDEL.

The hotkey for this dialogbox is <Alt-L>.

Another way for quick changing the drive is pressing the <Ctrl>-Key together with the letter of the desired 
drive. If the selected drice is protected by SafeDEL its contents will be immediately displayed in the file list
without opening any dialog boxes.

You may also use the Combo Box in the ToolBar to change the drive.



Help|About SafeDEL...
Displays a standard about dialog box with version and copyright information and the current status of 
SafeDEL.



 Help|Contents...
This menu item displays the contents of the SafeDEL help.



Help|Help on help...
This menu item displays help about the usage of the windows help system. The windows help displays 
the help file WINHELP.HLP which must be in your Windows directory or somewhere in your PATH.



Options|Confirmations...
With this dialogbox you're able to tell SafeDEL Undelete where you want to have a confirmation dialog.

See also:
    Confirmation dialogbox



View|Toolbar
This menu item enables or disables the toolbar below the menu.



Options|Delete Tracking...
This command opens a dialog in which you can enable or disable the SafeDEL Delete Tracking.

See also:
 Delete Tracking Dialog



Options|Protected drives...
This dialog displays all drives that are currently protected by SafeDEL and allows adding and removing of 
drives and resizing the SafeDEL Trashcan of every protected drive.

With Windows 95 you may also use the proterty dialog of any drive to change the SafeDEL settings for 
that drive.

See also:
 Protected drives dialog
 Windows 95 Shell-Extension



 File|Refresh
This command updates the contents of the file list.



Options|Exceptions...
This dialog displays all file and directory exceptions and allows you to change them. Common exceptions 
are all types of temporary files.

Another way to add names to the exception list is to use the Contextmenü of any object that is displayed 
in the file list.

See also:
 Add exceptions...



 File|File-Info...
This command displays a dialog box with detailed informations about the currently highlighted file.

The hotkey for this function is <Alt-I>.



 File|Undelete as...
This item is used to restore a deleted file under a different name or to a different directory or drive.

This command is disabled if no files are selected.

IMPORTANT: This command is not available in the current beta version of SafeDEL. It will be 
implementet in one of the future releases.



 View|List
In list mode the files in the file list are displayed in several columns side by side. Only the name of the file 
is displayed. The list is sorted by nane.

The menu item View|Details... switches the list back to detailed mode.

SafeDEL automatically remebers the last view mode when it starts.



 View|Details
In detailed mode the files in the file list are displayed one per row with additional information for every file. 
You may sort the list by every column with a simple mouse click on the column header. Use the context 
menu of the file list to show or hide some of the columns.

The menu item View|List... switches the list back to list mode.

SafeDEL automatically remebers the last view mode when it starts.



View|Statusbar
This menu item enables or disables the status bar at the bottom of the main window.



 View|Seperate by directories
With this menu item you may toggle the display of directories in the file list. In "directory mode" only 
deleted files from the current directory are displayed in the list. The current directory is displayed in the 
title line of the window. You may walk through the directories like in many file managers. In this mode 
SafeDEL Undelete is able to display existing files from the current directory as well.

In "drive mode" all deleted files from this drive are displayed at once without a directory structure.



 View|Show existing files
This menu item is only available if the deleted files are seperated by their directories. See "View|Seperate
by directories",

You may distinguisch deleted and existing files by their icon.



Select|Select all files
As the name says, this command selects all files in the file list.



Select|Remove all selections
This command removes all selections from the file list.



Select|Toggle all selections
This command toggles all selections in the file list.



Select|Select group...
This command or the hotkey <+> on the numeric keypad opens a dialog for entering a selection mask. 
After closing the dialog all matching files will be selected.

The file mask can contain Wildcards.



Select|Unselect group...
This command or the hotkey <+> on the numeric keypad opens a dialog for entering a selection mask. 
After closing the dialog the selection of all matching files will be removed.

The file mask can contain Wildcards.



Displays a help text for this dialog.



 File Menu
The following items are available:

 Undelete
 Undelete as
 Remove
 File-Info

 Change drive
 Refresh

 Exit



 Select Menu
The following items for selecting and unselecting files are available:

 Select group...
 Unselect group...

 Select all files
 Remove all selections
 Toggle all selections



 Options Menu
With the items of this menu you may configure SafeDEL.

 Confirmations

 Exceptions
 Protected files

 Delete Tracking



 View Menu
The following items are available:

 Toolbar
 Statusbar

 List
 Details

 Separate by directories
 Show existing files



 Help Menu
The following items are available:

 Contents
 About SafeDEL

In the shareware version the menu contains two additional items:

 Shareware
 Registration



 "About" dialog
This dialog displays the version, copyright and registered user of SafeDEL and whether SafeDEL is 
enabled or not.



"Confirmations" Dialog
With this dialog you may configure when SafeDEL will ask you for a confirmation before doing some 
action. Any change you make will apply both to the DOS and to the Windows Undelete program.

    Restoring files

If this checkbox is marked you will get a confirmation before SafeDEL restores a previous deleted file.

    Overwriting existing files

This checkbox is responsible for a confirmation before an existing file is overwritten if SafeDEL is 
restoring a deleted file.

    Deleting files

If this checkbox is marked SafeDEL asks you for a confirmation before it removes some deleted files from
the Trashcan.

    Operations with groups of files

With a mark in this checkbox you will get an additional confirmation before any file operation if more than 
one file is selected.

    Creating directories

Check this checkbox if you want to get a confirmation before SafeDEL creates directories while restoring 
a file.

    Sucessful operation

If this checkbox is marked you will get a confirmation after restoring or removing files.

    Delete with Drag-and-Drop

If you drag a file from File Manager or an other Source to the SafeDEL Undelete window you will get a 
confirmation before the file is deleted when this checkbox is marked.

    Closing WUNDEL

This one is clear, I think.



"Change drive" Dialog
This dialog box is used to select another drive for the file list. The dialog box displays all drives that are 
currently protected by SafeDEL. Highlight a drive and select "OK" to display it in the file list.

The hotkey for this dialogbox is <Alt-L>.

Another way for quick changing the drive is pressing the <Ctrl>-Key together with the letter of the desired 
drive. If the selected drive is protected by SafeDEL its contents will be immediately displayed in the file list
without opening any dialog boxes.

You may also use the Combo Box in the toolbar to change the drive.



"Define exceptions"
This dialog is responsible for file and directory exceptions. An exception is a file or directory mask. If any 
of this masks matches if SafeDEL tracks a deleted file the file will NOT be saved in the SafeDEL 
Trashcan. You may use wildcards in exception masks. By default the list contains common temporary or 
backup file types like "*.bak".

If you enter the name of a directory all subdirectories of this directory are excluded, too. A mask like "" will 
ignore all files in the directory "" and in all subdirectories of this directory! Directory masks without a drive 
specification (e.g. starting with ") are applied to all protected drives.

In Windows 95 you're free to use long filenames.

Add an exception mask:

Enter the mask in the edit field and press the "Add" button.

Remove an exception mask:

Highlight the desired exception mask in the list and press the "Remove" button.

There are two additional checkboxes in this dialog. The first controls the delete tracking of zero-sized files
and the second the delete tracking of files, that are bigger than the whole trashcan.

    Ignore files with 0 bytes

If this checkbox is marked all deleted files with no contents (file size is 0 byte) will be ignored by SafeDEL 
and not saved on the Trashcan.

    Ignore files bigger than Trashcan

If this checkbox is marked SafeDEL will ignore files that are bigger than the whole Trashcan of that drive.



"Delete Tracking"
With this dialog you can enable or disable the Delete Tracking of SafeDEL. This is a system wide setting, 
i.e. it affects all running DOS and Windows programs.

If SafeDEL is not installed that the upper radio button is disabled.



"Choose dialog"
This dialogbox enables you to add a new drive to the SafeDEL protection. The list displays every drive in 
your system that is currently not protected by SafeDEL. The drives for which a protection is possible are 
highlighted.

Use the slider to adjust the size of the SafeDEL Trashcan in percent of the total disk capacity. Common 
values for the Trashcan size are between 5% and 10%, the default value is 5%. In addition to the size of 
the Trashcan you may also add a day limit to that drive.



"Protected drives"
The list in this dialog displays all currently protected drives. You may use the buttons to add or remove a 
drive or to modify its Trashcan settings.

[New] Adds a new drive to the list
[Edit] Modifies the Trashcan settings for the highlighted drive
[Remove] Removes the highlighted drive from the list

The changes are applied immediately after you have pressed the [Ok] button. It is not necessary to reboot
your system.



"Modify Trashcan settings"
With this dialog you're able to modify the settings of the SafeDEL Trashcan.

Use the slider to adjust the size of the Trashcan in percent of the total disk capacity and optionally enter a
day limit for the files in the Trashcan.

Common values for the Trashcan size are between 5% and 10%, the default value is 5%.



"Datei-Info"
This dialog displays all available information about an object of the file list.

Use this dialog if the file list is in list view and you want to get additional informations about a displayed 
file.



Toolbar
The Toolbar is the small part of the windows below the menu. It contains several button to provide a quick
mouse access for the most common function of SafeDEL Undelete.

Every button displays a small help text in the statusbar if you press it and also displays a small tooltip help
if you keep the mouse over the button for a few moments.



Statusbar
The statusbar at the bottom of the windows displays a summary about the contents of the file list. If you 
walk through the menus the statusbar displays a short description of every menu item.

If you press a button of the Toolbar the statusbar offers a short description, too.



Benefits and drawbacks of SafeDEL
Benefits:

· Safe undelete of files even after a certain time
· SafeDEL works with DOS, Windows 3.x and Windows 95.
· Simple user interface for restoring deleted files
· Low memory consumption
· Complete integration into the Windows 95 shell

Drawbacks:

· Deleting a files takes a slightly longer time
· If SafeDEL fails it is difficult to restore a file with other Undelete tools
· The disk space occupied by deleted files is not freed until the Trashcan has reached its 

maximum size.



Wildcards
You may use wildcards at many places inside SafeDEL. SafeDEL accepts standard MS-DOS wildcards, 
but also accepts wildcards that are only valid with Windows 95 and with the popular shareware command 
interpreter 4DOS (from JP-Soft).



 Hotkeys
You may use the following hotkeys to gain a quick access to certain functions of SafeDEL Undelete.

<F1> - Displays a help text for the current situation
<Alt-D> - Opens the File menu
<Alt-H> - Open the Help menu 
<Alt-I> - File informations
<Alt-L> - Changes the drive
<Alt-O> - Open the Options menu
<Alt-R> - Refreshes the file list
<Alt-X> - Closes the program

<Enter>
<Einfg> - Restores the selected files
<Entf> - Removes the selected files
<Leerz> - Toggles the selection of the highlighted file
<Num +> - Selects a group of files
<Num -> - Unselects a group of files
<Num *> - Toggles all selections



Select files
All file commands act on the currently selected files. If no file is selected that the highlighted file is 
considered to be selected.

Use the right mousebutton to select a single file. Or use the cursor keys to move the focus to the file 
and press the Space key.

Use the "Group" commands from the Select menu to select or unselect groups of files.



The SafeDEL Trashcan
The SafeDEL Trashcan is a hidden directory on every protected drive. SafeDEL stores the deleted files in 
that directory. The deleted files stay in the Trashcan until they are restored or finally removed from the 
disk.

You can adjust the size of the Trashcan individually for every drive. As default the Trashcan occupies a 
maximum of 5% of the total disk capacity.

If files are deleted SafeDEL checks the current size of the Trashcan and repeatedly removes files from 
the Trashcan until the new deleted files have enough room. SafeDEL removes the oldest deleted files 
first, that are the files which are stored in the Trashcan for the longest time and thus may not be needed 
to be restored very likely.

SafeDEL uses a control file called SAFEDEL.INF to link every file in the Trashcan with its original name.



How SafeDEL works?
SafeDEL is able to store deleted files in a hidden directory called the SafeDEL Trashcan rather than 
deleting these files physically from the disk.

This process works hidden in the background, you hardly ever notice the presence of SafeDEL during 
your normal work except for a slightly higher time consumption for deleting files. If you delete a file using 
your favorite program or at the DOS prompt, SafeDEL will track this and moves the file silently into its 
Trashcan.

Under plain DOS SafeDEL uses a terminate-and-stay-resident (TSR) program SAFEDEL.COM for this 
purpose. You should add this file to your Autoexec.bat file if the SetupWizard hadn't done this for you. 
Under Windows SafeDEL uses two additional files, namely the 32-Bit virtual driver VSAFEDEL.VXD and 
the DLL SAFEDEL.DLL. Windows will automatically load these two files if the SafeDEL TSR program is in
memory if windows starts. Adding SAFEDEL.COM to your Autoexec.bat is the only important step to take 
if you want to install the SafeDEL delete tracking.

To restore previous deleted file you may use a comfortable DOS or Windows Undelete program or a DOS
command line tool. These programs are able to restore deleted files in an easy user friendly way.

If you temporary want to reject the protection of SafeDEL simply press a <Shift> key while you're deleting 
some files. SafeDEL will recognize this and ignores these files. With SafeDEL loaded the DOS commands
"DEL", "ERASE" and "MOVE" accept an additional parameter which will prevent SafeDEL from saving 
these files, too.

See also:
 Delete files without SafeDEL protection
 Finally Remove deleted



Delete files without SafeDEL protection
If SafeDEL recognizes a pressed <Shift> key while some files are deleted SafeDEL ignores these files. 
They are deleted in the normal way and not stored in the SafeDEL Trashcan.

SafeDEL enhances the DOS commands "DEL", "EREASE" and "MOVE" with an additional parameter. If 
you add /f to any of these commands the involved files are ignored by SafeDEL and not moved to the 
Trashcan. This works under all DOS versions known to me and also with 4DOS, NDOS and also inside 
an OS/2 DOS window.

Example:

 del test.dat /f

SafeDEL contains an extension for the Windows 3.x File Manager that contains a ForceDelete command. 
The SetupWizard should have installed this extension.

SafeDEL adds an ForceDelete command to every file and directory in the Windows 95 Shell if the 
SafeDEL Shell Extension is installed.



Remove files from the Trashcan
If you urgent need some additional disk space you may remove files from the SafeDEL Trashcan. Just 
select some files in the SafeDEL Undelete program and press the <Del> key or select "Remove" from the 
File menu.

The selected files will than be removed from the Trashcan and the occupied disk space is freed.

Windows 95:

If you use the SafeDEL Taskbar Icon for Windows 95 you may use the icon menu to clear the whole 
Trashcan on selected drives.

If the SafeDEL shell extension is installed every protected drive has a "Clear Trashcan" command in its 
context menu which can be used to empty the whole Trashcan.



Restore previous deleted files
To restore files launch SafeDEL Undelete and select the appropriate files in the file list. That select 
"Undelete" from the File menu or use the hotkey <Ins> to restore the selected files.



Change drive
To change the drive which is display in the file list use may either us the hotkey <Alt-L> or the item 
"Change drive" from the File menu to display a dialog with the available drives.

A much easier way is to press the <Ctrl> key together with the letter of the desired drive.

You may also use the drive list in the Toolbar to change the current drive.



Supported drives
SafeDEL is prepared for local harddisks and devices that acts like harddisks (e.g. IOMEGA ZIP drive) and
some kinds of net drives. You cannot use SafeDEL with floppy disk. You may protect RAM disks with 
SafeDEL, but I think this is pretty useless.

To add SafeDEL protection to a drive use the item "Protected drives" from the Options menu and select 
the "Add" button.

If you're working with Windows 95 you may use the property page of supported drives to enable or 
disable SafeDEL protection for that drive.



Enable/disable Delete Tracking
You may enable or disable SafeDEL at every time. Just use the "Delete Tracking" command from the 
Options menu or use the program SAFEDEL.COM with some special arguments.

SAFEDEL.COM accept the following argument for disabling SafeDEL:

    SAFEDEL /-

Use the following command to enable SafeDEL:

    SAFEDEL /+

If you have installed the SafeDEL TrayIcon you may use the icon menu or just a double click on the icon 
to alter the status of SafeDEL. The current status is displayed in the taskbar icon.



Uninstall SafeDEL
If you want to remove SafeDEL from your system you should use the UNINSTAL.EXE program which is 
provided with SafeDEL. This ensures that SafeDEL is completely removed from your system. Under 
Windows 95 you may use the Add/Remove-Software Icon from the Control Panel.

The uninstall program will clear all previous deleted files from the SafeDEL Trashcan, removes all 
SafeDEL program files and reverts all changes that are made to any configuration file, including the 
Windows 95 Registry.



Future enhancements of SafeDEL
Hopefully some of the following items are included in future releases of SafeDEL:

· Display the contents of a deleted file
· 32 Bit Undelete program for Windows 95
· Small Trashcan icon for Windows 3.x (next project)
· True undelete capability for files that are not protected by SafeDEL
· Move SafeDEL to other operating systems like Windows NT and OS/2.



Day limit
SafeDEL uses a day limit to keep the size of the SafeDEL Trashcan as small as possible. If SafeDEL is 
loaded or if SafeDEL notices that the Trashcan is full it will delete all files that are at least for "day limit" 
days stored in the Trashcan. The default for the day limit is five days.

This ensures a regularly clean up in the Trashcan so that it doesn't store deleted files for weeks. But of 
course, you can disable this feature.



Remove with drag-and-drop
You may use the Windows Undelete program to remove files with drag-and-drop. Just drag a file from the 
File Manager, the Explorer or another drag-and-drop source and drop them onto the main window of the 
Windows Undelete program.

If you press the <Shift> key while dropping the files onto the window SafeDEL will ForceDelete these files.



 SafeDEL 1.0 beta6
Delete Tracking System for DOS and Windows

Copyright (c) 1996 by Frank Kintrup

All rights reserved. This program is shareware. You may use this software for up to 30 days to determine 
if it meets your requirements. After this period you must either register this software or remove it from your
system!

There is no warranty or claim of fitness or reliability. The program is distributed AS IS, and the author shall
not be held liable for any loss of data, down time, loss of revenue or any other direct or indirect damage or
claims caused by this software.



Credits
The code for comparing wildcards is from Arne de Bruijn and can be found in the SWAG Library.

The unzip functions from my SetupWizard were originally written from members of the info-zip group and 
from C to Pascal adapted by Christian Ghisler and finally modified to fulfill my needs.

I wish to thank all beta testers, especially Joachim Greive, for there indispensable help.



File list
The file list fills the main portion of the Undelete window. It displays the deleted files and allows selecting 
and sorting them.

See also:
 Selecting files
 Sorting the list



Sorting the file list
You may sort the file list by a simple click on the header of any list column. If you click another time on 
that column header the sort direction is reversed.



Disk caches
In a few words:    You should use them!

To get the most speed out of SafeDEL it is recommended that you use a disk cache program like 
SMARTDRV or any other disk cache. Sometimes it is required that the cache program is loaded before 
SafeDEL to make sure that SafeDEL can benefit from the cache.



Registieren
This command opens a dialog for entering your registration code. The registration code will convert the 
shareware version into the registered version.



Registration
SafeDEL 1.0 beta6

The registration fee for SafeDEL is DM 40,- or US$30. Purchasing a license for SafeDEL entitles you to 
use the software on any and all computers available to you, provided you do not operate SafeDEL on 
more than one computer at a time and you do not operate SafeDEL on a network or a multi-user system. 
If you would like a network or multi-user license, please contact me for details.

The registration code is applicable to all future releases of SafeDEL, except for "very big" updates I may 
decide to charge you with another small fee.

To register your copy of SafeDEL, fill in the order form contained in the file REGISTER.TXT and mail it 
along with cash (be careful, you are responsible for any loss!) or your cheque in US or German funds to 
my address below.

You may also transfer the funds to my bank:

Sparkasse Paderborn, Paderborn, Germany
Account number: 16106304
Account owner: Frank Kintrup

Please ensure to transfer enough funds to cover all required service charges! Sorry, I cannot accept credit
cards at this time, but I'm working on it. Because of the high service charge to collect cheques from 
foreign countries please add US$10 to your cheque.

You may contacting me at the following addresses:

Postal mail: Phone/Fax:
 Frank Kintrup  Phone: +49 05251-680025
 Foelsener Weg 21  Fax: +49 05251-680026
 D-33100 Paderborn
 Germany

Internet:
 mail: nico@uni-paderborn.de
 www: http://pbhrzs0.uni-paderborn.de/~q92131



License agreement
License agreement

This version of SafeDEL (the "software") is NOT public domain or free software, but is being distributed as
"shareware" for EVALUATION PURPOSES ONLY. Your use of this Software indicates your agreement to 
the terms and conditions of this license.

The SafeDEL software is protected by German copyright laws and international treaty provisions. You 
may not reverse engineer, decompile, disassemble, or create derivative works based on the software for 
any purpose other than creating an adaptation to the software as an essential step in its utilization for 
your own use.

You are granted a limited license for individual use of this shareware software for a 30-day evaluation 
period on a private, non-commercial basis, for the express purpose of determining whether SafeDEL is 
suitable for your needs. At the end of this 30-day evaluation period, you must either purchase a license for
SafeDEL or discontinue using it.

What does this mean? If you use this software on a continued basis, you must purchase a license for its 
use. SafeDEL is NOT free, and I am not giving away free copies. I give you the opportunity to try it before 
paying for a license for continued use. It is that simple. Try it for 30 days. Then either pay for it, or quit 
using it.

Paying for a license to continue using the software product is not only required, but also allows me to 
provide support and updates, and stay in business. Licensed users receive a registration code which will 
remove the opening shareware reminder screen. Registration of the licensed copy entitles the registered 
user to receive technical support (by phone, fax and postal mail and e-mail.

You are granted a limited license to copy the SHAREWARE version of SafeDEL only for the trial use of 
other persons in accordance with the limitations identified in this license, and subject to the following 
restrictions:

1. You MAY NOT distribute the software in connection
with any other product or service.

2. You MAY NOT copy or distribute the software in
modified form. (Any distribution must contain
the unmodified installation file SFDL100E.EXE,
WITHOUT ALTERATION.)



Shareware reminder
SafeDEL displays this shareware reminder on every start of the DOS or Windows Undelete program. If 
you register this software this screen will disappear.

See also:
Registration
License agreement



Registration
This dialog is for verifying your personal registration code. In conjunction with your name the registration 
code will "unlock" the shareware version and removes the shareware reminder.

Please enter the name for which you have registered SafeDEL und the exact registration code.

A correct input will create the file SAFEDEL.KEY. SafeDEL Undelete checks for the presence and the 
contents of this file on every start. All further shareware releases of SafeDEL will be automatically 
converted to a full version if this file is present (of course, it must be a valid file).

THE REGISTRATION CODE IS A PERSONAL CODE WHICH WORKS ONLY IN CONJUCTION WITH 
YOUR NAME. YOU MAY NEVER GIVE AWAY COPIES OF THE REGISTRATION CODE OR THE FILE 
'SAFEDEL.KEY' TO ANOTHER PERSON!



 Program files
SafeDEL consists of the following files:

SAFEDEL.COM - TSR program for Delete Tracking
SAFEDEL.INI - Configuration file for all SafeDEL programs
SAFEDEL.DLL - DLL for Delete Tracking
UNDEL.EXE - Undelete for DOS
UD.EXE - Command line Undelete for DOS
UNDEL.HLP - Help file for DOS Undelete
VSAFEDEL.VXD - Windows-VxD for Delete Tracking
WUNDEL.EXE - Undelete for Windows
WUNDEL.HLP - Help file for Windows Undelete
UNINSTAL.EXE - UnInstall program for SafeDEL

Additional Windows programs:

SFDLFEXT.DLL - Extension for the Windows File Manager
SFDLFEXT.HLP - Help for the File Manager Extension
SFDLSEXT.DLL - SafeDEL Shell-Extension for Windows 95
SFDLFEXT.HLP - Help for the Shell extension
SFDLTRAY.EXE - Windows 95 Taskbar Icon for SafeDEL
SFDLTRAY.HLP - Help for the Taskbar icon

Other files:

PROGINFO.TXT - Describes other program from the same Author
README.TXT - General informations about SafeDEL
REGISTER.TXT - Registration form

IMPORTANT:

Please ensure that ALL files of SafeDEL are stored in the same subdirectory on your harddisk.



 UNDEL.EXE
UNDEL.EXE is the DOS Undelete program used to restore previous deleted files. The help file 
UNDEL.HLP belongs to this program.

The Windows Undelete program is called WUNDEL.EXE.

See also:
 Usage of UNDEL.EXE



 UD.EXE
UD.EXE is a simple command line utility to restore previous deleted files. It accepts the same arguments 
like UNDEL.EXE, but because of the missing full screen user interface it is very small (about 15 KByte).

See also:
 Usage of UD.EXE



 UNDEL.HLP
This file contains the help texts for the DOS Undelete program UNDEL.EXE. The file is not compatible 
with the windows help system. It can only be viewed within UNDEL.EXE.

This file should be stored in the same subdirectory as all other SafeDEL files.



 WUNDEL.EXE
WUNDEL.EXE is the SafeDEL Undelete program for Windows. The help file WUNDEL.HLP belongs to 
this program.

The program accepts either a drive specification or a subdirectory as arguments.

The DLL SAFEDEL.DLL is used to update the file list "on the fly", if you delete some files if Undelete is 
open. If this DLL is not loaded you will get a warning message when you launch Undelete.

The DOS Undelete program is called UNDEL.EXE.



 WUNDEL.HLP
This file contains the help texts for the Windows Undelete program WUNDEL.EXE.

This file should be stored in the same subdirectory as all other SafeDEL files.



 SAFEDEL.COM
The resident program SAFEDEL.COM is one part of the SafeDEL kernel. The other part is made up of the
Windows files VSAFEDEL.VXD and SAFEDEL.DLL.

SAFEDEL.COM installs itself resident in memory and tracks deleted files. Instead of deleting the files they
will be moved into a hidden subdirectory called the SafeDEL Trashcan.

It is highly recommended that you load SAFEDEL.COM from your startup file AUTOEXEC.BAT!

See also:
 Usage of SAFEDEL.COM



 SAFEDEL.DLL
The DLL SAFEDEL.DLL is used to automatically update the file list of WUNDEL.EXE if you deleted a file 
while the Undelete program is open.

Windows automatically loads SAFEDEL.DLL if SAFEDEL.COM is present in memory when Windows 
loads. You cannot load SAFEDEL.DLL after Windows has started.

IMPORTANT:

Please make sure that SAFEDEL.DLL is stored in the same directory as all other files from SafeDEL. This
ensures that Windows is able to find these files if it loads.



 VSAFEDEL.VXD
The 32-bit virtual driver VSAFEDEL.VXD is the kernel of SafeDEL inside Windows 3.x (enhanced mode) 
and Windows 95. SafeDEL is not able to track deleted files in Windows if this driver is not loaded!

Windows automatically installs VSAFEDEL.VXD if SAFEDEL.COM present im memory when Windows 
loads. You cannot load VSAFEDEL.VXD after Windows has started.

IMPORTANT:

Please make sure that SAFEDEL.DLL is stored in the same directory as all other files from SafeDEL. This
ensures that Windows is able to find these files if it loads. If Windows cannot find this file it displays an 
ugly error message, but the only effect is that SafeDEL cannot track deleted files.



 SAFEDEL.INI
The file SAFEDEL.INI stores all configuration data for the SafeDEL program files. You should never 
change this file on your own, although it's a text file. Please use the dialogs of SafeDEL instead. This 
ensures that all data contained in the configuration file is valid.

Please make sure that SAFEDEL.INI is stored in the same directory as all other files from SafeDEL. This 
ensures that SafeDEL is able to find this file. If a SafeDEL program cannot find this file it assumes default 
values.



 SFDLTRAY.EXE
(Windows 95 only)

The program SFDLTRAY.EXE adds a small icon to the notification area of the Windows 95 Taskbar. This 
icon displays the current status of the SafeDEL Delete Tracking and may be used to alter the state of 
SafeDEL.

This program is of no use in Windows 3.x und will not be installed from the SetupWizard under this 
environment.

During the installation process a shortcut of SFDLTRAY.EXE is placed in the Startup-Folder of your Start 
Menu.

Additional informations:    Windows 95 Taskbar Icon.



 SFDLTRAY.HLP
(Windows 95 only)

This file contains the help texts for the SafeDEL Taskbar Icon SFDLTRAY.EXE.

This file should be stored in the same subdirectory as all other SafeDEL files.



 SFDLSEXT.HLP
(Windows 95 only)

This file contains the help texts for the SafeDEL Shell Extension SFDLSEXT.DLL.

This file should be stored in the same subdirectory as all other SafeDEL files.



 SFDLFEXT.HLP
This file contains the help texts for the SafeDEL File Manager Extension SFDLFEXT.DLL.

This file should be stored in the same subdirectory as all other SafeDEL files.



 SFDLFEXT.DLL
The File Manager Extension SFDLFExt extents the Windows File Manager with some additional 
commands. With the extension menu "SafeDEL" you have access to these functions. Using the menu you
may enable or disable SafeDEL, launch the SafeDEL Undelete program WUNDEL.EXE or you may 
delete the selected files without saving them to the SafeDEL Trashcan (ForceDelete).

The SetupWizard installs this Extension by default.



 SFDLSEXT.DLL
(Windows 95 only)

These DLL extents the Windows 95 Shell with some nice features. It adds a page to the property dialog of
any drive to control the Trashcan settings for this drive. You may launch SafeDEL Undelete from the 
context menu of every directory or drive object. And all files and directories now have a ForceDelete 
command to remove the object without saving it to the SafeDEL Trashcan.

The SetupWizard installs this Extension by default on Windows 95 systems. You cannot use this file on 
Windows 3.x.



 UNINSTAL.EXE
UNINSTAL.EXE completely removes SafeDEL from your system. It removes all files from SafeDEL and 
all remaining deleted files in the SafeDEL Trashcan, revert any changes made to your configuration files 
and removes every item belonging to SafeDEL from the Windows 95 Registry.



 PROGINFO.TXT
This file contains short descriptions of other shareware programs written by me. Since all these other 
programs are only available in German, this file contains only German descriptions, too.



 README.TXT
This file contains general informations about SafeDEL. You should read this file!



 REGISTER.TXT
This file contains the registration form for SafeDEL.



 Control file SAFEDEL.INF
The control file SAFEDEL.INF, which is created by SafeDEL in every SafeDEL Trashcan, links the deleted
files in the Trashcan with their real names. If this file is damaged or altered it may be impossible for 
SafeDEL to restore some files.



SAFEDEL.COM: Usage
SAFEDEL.COM recognizes the following arguments:

/- or /off - Disables SafeDEL
/+ or /on -    Enables SafeDEL
/i - Displays the status of SafeDEL
/r - Removes SafeDEL from memory
/low - Loads SafeDEL into low memory



Undelete files on the command line
You can use the SafeDEL Undelete programs UNDEL.EXE and the command line tools UD.EXE to 
restore files from the DOS command line without launching the user interface of either UNDEL.EXE or 
WUNDEL.EXE.

Both programs offer the same functions on the command line, however, since UD.EXE doesn't provide a 
full screen user interface, it is much smaller than UNDEL.EXE.

To restore a file just include the names of the files on the command line. You may use wildcards, drive 
letters and directories. On the command line the same confirmations apply like in the full screen undelete 
programs.

Usage:

 UNDEL    <file 1>    <file 2>    <...>

or

 UD    <file 1>    <file 2>    <...>

You may use the following keys to reply to such a confirmation:

<Q>, <Esc> Aborts the program.
<N> Skips the displayed files
<Y>, <Enter> Restores the displayed file
<A> Defaults to "yes" on all other queries.



    Author
You may contact me at the following addresses:

Address: Phone/Fax:
      Frank Kintrup       Phone: +49 05251-680025
      Foelsener Weg 21       Fax: +49 05251-680026
      D-33100 Paderborn
      Germany

Internet:
      mail: nico@uni-paderborn.de
      www: http://pbhrzs0.uni-paderborn.de/~q92131



Use this edit field to enter a new file or directory mask or to change an existing one. With the "Add" button nearby you can add the 
contents of the edit field to the exception list.



This list displays all exceptions that are defined for SafeDEL. All files and directories listed here are NOT PROTECTED by the SafeDEL 
Delete Tracking.



Use this button to remove the highlighted item from the exception list.



If this checkbox is marked than empty files are ignored by the SafeDEL Delete Tracking. 



If this checkbox is marked than files that are bigger than the Trashcan of that drive are ignored by the SafeDEL Delete Tracking. 



This button add the contents of the nearby edit field to the exception list.



This list displays all drives of your system that are NOT protected by SafeDEL. Drives, for which a protection is possible, are 
highlighted.



This slider determines the size of the Trashcan in percent of the total disk capacity.
You can conserve disk space by reducing the size of the Trashcan. Common values for the Trashcan size are between 5% and 10%.



This edit field is used for changed the day count for deleted files.



This checkbox enables or disables the day count for deleted files. If this box is checked the deleted files are automatically removed 
after this number of days.



This up-down control increments or decrements the day count for deleted files.



This list displays all drives that are protected by SafeDEL.



Use this button to add a new drive to the SafeDEL protection.



Use this button to change the Trashcan settings for the current drive.



Use this button to remove a drive from the list of currently protected drives.



This list displays all drives that are protected by SafeDEL.



Als for a confirmation before a file is restored.



Asks for a confirmation if a file already exists during restoring a file.



Asks for confirmation before a file is removed from the Trashcan.



Asks for an extra confirmation if more than one file is selected.



Asks for a confirmation if a subdirectory does not exists during restoring a file.



Asks for a confirmation if you drag some files from the File Manager or another drag-and-drop source to the Undelete Window to 
delete them.



Displays the result of a file operation.



Asks for a confirmation before SafeDEL Undelete is closed.



 Contextmenu
you can access the context menu of any object in the file list by pressing the secondary mouse button for 
approx. a half second on that object.

This menu contains commands only that are applicable to that object.

You may use the context menu to show or hide columns in the file list.



This radio button enables SafeDEL. This button is disabled if SafeDEL is not loaded.



This radio button disables SafeDEL.



 File|Exit
This command closes the Undelete program. What did you expect else?






